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I Symbols Used in This Document

A Warning
Instructions that, if ignored, could result in death, serious personal injury, or property damage caused by
incorrect operation of the equipment. These must be observed for safe operation.

/A Caution
Instructions that, if ignored, could result in personal injury or property damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

3% Important

Instructions including important information that must be observed to avoid damage and injury or
improper use of the product. Be sure to read these instructions.

»>» Note

Instructions including notes for operation and additional explanations.

Instructions explaining basic operations of your product.

»» Note

* Icons may vary depending on your product.



I Touch-enabled Device Users (Windows)

For touch actions, you need to replace "right-click" in this document with the action set on the operating
system. For example, if the action is set to "press and hold" on your operating system, replace "right-click"
with "press and hold."



I Trademarks and Licenses

» Microsoft is a registered trademark of Microsoft Corporation.

» Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or
other countries.

* Mac, Mac OS, macOS, OS X, AirPort, App Store, AirPrint, the AirPrint logo, Safari, Bonjour, iPad,
iPhone and iPod touch are trademarks of Apple Inc., registered in the U.S. and other countries.

* 10S is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under
license.

» Google Cloud Print, Google Chrome, Chrome OS, Chromebook, Android, Google Drive, Google Apps
and Google Analytics are either registered trademarks or trademarks of Google Inc. Google Play and
Google Play Logo are trademarks of Google LLC.

* Adobe, Acrobat, Flash, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB
(1998) are either registered trademarks or trademarks of Adobe Systems Incorporated in the United
States and/or other countries.

* Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.

» Autodesk and AutoCAD are registered trademarks or trademarks of Autodesk, Inc., and/or its
subsidiaries and/or affiliates in the USA and/or other countries.

* USB Type-C™ is a trademark of USB Implementers Forum.

»>» Note

» The formal name of Windows Vista is Microsoft Windows Vista operating system.

Copyright (c) 2003-2015 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.



Apache License
Version 2.0, January 2004

http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under
the License, as indicated by a copyright notice that is included in or attached to the work (an example
is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship. For the purposes of this License,
Derivative Works shall not include works that remain separable from, or merely link (or bind by nhame)
to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity
authorized to submit on behalf of the copyright owner. For the purposes of this definition, "submitted"
means any form of electronic, verbal, or written communication sent to the Licensor or its
representatives, including but not limited to communication on electronic mailing lists, source code
control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor for
the purpose of discussing and improving the Work, but excluding communication that is
conspicuously marked or otherwise designated in writing by the copyright owner as "Not a
Contribution."

"Contributor” shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.



2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and
otherwise transfer the Work, where such license applies only to those patent claims licensable by
such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of
their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent
litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the
Work or a Contribution incorporated within the Work constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for that Work shall terminate
as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and

2. You must cause any modified files to carry prominent notices stating that You changed the files;
and

3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright,
patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that
You distribute must include a readable copy of the attribution notices contained within such
NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in at
least one of the following places: within a NOTICE text file distributed as part of the Derivative
Works; within the Source form or documentation, if provided along with the Derivative Works; or,
within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not
modify the License. You may add Your own attribution notices within Derivative Works that You
distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or

different license terms and conditions for use, reproduction, or distribution of Your modifications,

or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of
the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.



7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or
FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated with Your
exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages
or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof,
You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other
liability obligations and/or rights consistent with this License. However, in accepting such obligations,
You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any
liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
such warranty or additional liability.

END OF TERMS AND CONDITIONS

---- Part 1: CMU/UCD copyright notice: (BSD like) -----

Copyright 1989, 1991, 1992 by Carnegie Mellon University

Derivative Work - 1996, 1998-2000

Copyright 1996, 1998-2000 The Regents of the University of California
All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose and
without fee is hereby granted, provided that the above copyright notice appears in all copies and that both
that copyright notice and this permission notice appear in supporting documentation, and that the name of
CMU and The Regents of the University of California not be used in advertising or publicity pertaining to
distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES
WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF THE
UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION,
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

--—-- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----
Copyright (c) 2001-2003, Networks Associates Technology, Inc

All rights reserved.



Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be
used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----
Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER "AS IS" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----

Copyright ¢ 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, U.S.A. All
rights reserved.



Use is subject to license terms below.
This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 5: Sparta, Inc copyright notice (BSD) -----
Copyright (c) 2003-2012, Sparta, Inc
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Sparta, Inc nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS I1S"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
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TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 6: Cisco/BUPTNIC copyright notice (BSD) -----

Copyright (c) 2004, Cisco, Inc and Information Network Center of Beijing University of Posts and
Telecommunications.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Cisco, Inc, Beijing University of Posts and Telecommunications, nor the names of
their contributors may be used to endorse or promote products derived from this software without specific
prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS I1S"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 7: Fabasoft R&D Software GmbH & Co KG copyright notice (BSD) -----
Copyright (c) Fabasoft R&D Software GmbH & Co KG, 2003 oss@fabasoft.com
Author: Bernhard Penz <bernhard.penz@fabasoft.com>

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Fabasoft R&D Software GmbH & Co KG or any of its subsidiaries, brand or product names
may not be used to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER "AS IS" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
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SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

---- Part 8: Apple Inc. copyright notice (BSD) -----
Copyright (c) 2007 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

---- Part 9: Sciencelogic, LLC copyright notice (BSD) -----
Copyright (c) 2009, SciencelLogic, LLC
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of ScienceLogic, LLC nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS 1S" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
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FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

LEADTOOLS
Copyright (C) 1991-2009 LEAD Technologies, Inc.

CMap Resources

Copyright 1990-2009 Adobe Systems Incorporated.
All rights reserved.

Copyright 1990-2010 Adobe Systems Incorporated.
All rights reserved.

Redistribution and use in source and binary forms, with or
without modification, are permitted provided that the
following conditions are met:

Redistributions of source code must retain the above
copyright notice, this list of conditions and the following
disclaimer.

Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials
provided with the distribution.

Neither the name of Adobe Systems Incorporated nor the names
of its contributors may be used to endorse or promote

products derived from this software without specific prior

written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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MIT License
Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright 2000 Computing Research Labs, New Mexico State University
Copyright 2001-2015 Francesco Zappa Nardelli

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE COMPUTING
RESEARCH LAB OR NEW MEXICO STATE UNIVERSITY BE LIABLE FOR ANY CLAIM, DAMAGES OR
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

Written by Joel Sherrill <joel@OARcorp.com>.
COPYRIGHT (c) 1989-2000.
On-Line Applications Research Corporation (OAR).

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby
granted, provided that this entire notice is included in all copies of any software which is or includes a
copy or modification of this software.

THIS SOFTWARE IS BEING PROVIDED "AS 1S", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY.
IN PARTICULAR, THE AUTHOR MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND
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CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY
PARTICULAR PURPOSE.

(1) Red Hat Incorporated
Copyright (c) 1994-2009 Red Hat, Inc. All rights reserved.

This copyrighted material is made available to anyone wishing to use, modify, copy, or redistribute it
subject to the terms and conditions of the BSD License. This program is distributed in the hope that it will
be useful, but WITHOUT ANY WARRANTY expressed or implied, including the implied warranties of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. A copy of this license is available at
http://www.opensource.org/licenses. Any Red Hat trademarks that are incorporated in the source code or
documentation are not subject to the BSD License and may only be used or replicated with the express
permission of Red Hat, Inc.

(2) University of California, Berkeley
Copyright (c) 1981-2000 The Regents of the University of California.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the University nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS I1S" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The FreeType Project LICENSE

2006-Jan-27
Copyright 1996-2002, 2006 by
David Turner, Robert Wilhelm, and Werner Lemberg

Introduction
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The FreeType Project is distributed in several archive packages; some of them may contain, in addition to
the FreeType font engine, various tools and contributions which rely on, or relate to, the FreeType Project.

This license applies to all files found in such packages, and which do not fall under their own explicit
license. The license affects thus the FreeType font engine, the test programs, documentation and
makefiles, at the very least.

This license was inspired by the BSD, Artistic, and IJG (Independent JPEG Group) licenses, which all
encourage inclusion and use of free software in commercial and freeware products alike. As a
consequence, its main points are that:

o We don't promise that this software works. However, we will be interested in any kind of bug reports.
(Cas is' distribution)

o You can use this software for whatever you want, in parts or full form, without having to pay us.
(‘royalty-free' usage)

o You may not pretend that you wrote this software. If you use it, or only parts of it, in a program, you
must acknowledge somewhere in your documentation that you have used the FreeType code. ('credits')

We specifically permit and encourage the inclusion of this software, with or without modifications, in
commercial products.

We disclaim all warranties covering The FreeType Project and assume no liability related to The
FreeType Project.

Finally, many people asked us for a preferred form for a credit/disclaimer to use in compliance with this
license. We thus encourage you to use the following text:

Portions of this software are copyright © <year> The FreeType
Project (www.freetype.org). All rights reserved.
Please replace <year> with the value from the FreeType version you actually use.

Legal Terms

Throughout this license, the terms “package', "FreeType Project', and "FreeType archive' refer to the set
of files originally distributed by the authors (David Turner, Robert Wilhelm, and Werner Lemberg) as the
"FreeType Project’, be they named as alpha, beta or final release.

“You' refers to the licensee, or person using the project, where “using' is a generic term including
compiling the project's source code as well as linking it to form a “program’ or “executable’.

This program is referred to as “a program using the FreeType engine'.

This license applies to all files distributed in the original FreeType Project, including all source code,
binaries and documentation, unless otherwise stated in the file in its original, unmodified form as
distributed in the original archive.

If you are unsure whether or not a particular file is covered by this license, you must contact us to verify
this.
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The FreeType Project is copyright (C) 1996-2000 by David Turner, Robert Wilhelm, and Werner Lemberg.
All rights reserved except as specified below.

1. No Warranty

THE FREETYPE PROJECT IS PROVIDED "AS I1S' WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL ANY OF THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY DAMAGES CAUSED BY THE USE OR THE INABILITY
TO USE, OF THE FREETYPE PROJECT.

2. Redistribution

This license grants a worldwide, royalty-free, perpetual and irrevocable right and license to use, execute,
perform, compile, display, copy, create derivative works of, distribute and sublicense the FreeType Project
(in both source and object code forms) and derivative works thereof for any purpose; and to authorize
others to exercise some or all of the rights granted herein, subject to the following conditions:

o Redistribution of source code must retain this license file (FTL.TXT') unaltered; any additions, deletions
or changes to the original files must be clearly indicated in accompanying documentation. The copyright
notices of the unaltered, original files must be preserved in all copies of source files.

o Redistribution in binary form must provide a disclaimer that states that the software is based in part of
the work of the FreeType Team, in the distribution documentation. We also encourage you to put an URL
to the FreeType web page in your documentation, though this isn't mandatory.

These conditions apply to any software derived from or based on the FreeType Project, not just the
unmodified files. If you use our work, you must acknowledge us. However, no fee need be paid to us.

3. Advertising

Neither the FreeType authors and contributors nor you shall use the name of the other for commercial,
advertising, or promotional purposes without specific prior written permission.

We suggest, but do not require, that you use one or more of the following phrases to refer to this software
in your documentation or advertising materials: “FreeType Project', "FreeType Engine', "FreeType library',
or "FreeType Distribution'.

As you have not signed this license, you are not required to accept it. However, as the FreeType Project
is copyrighted material, only this license, or another one contracted with the authors, grants you the right
to use, distribute, and modify it.

Therefore, by using, distributing, or modifying the FreeType Project, you indicate that you understand and
accept all the terms of this license.

4. Contacts

There are two mailing lists related to FreeType:

o freetype@nongnu.org

17



Discusses general use and applications of FreeType, as well as future and wanted additions to the library
and distribution.

If you are looking for support, start in this list if you haven't found anything to help you in the
documentation.

o freetype-devel@nongnu.org

Discusses bugs, as well as engine internals, design issues, specific licenses, porting, etc.
Our home page can be found at

http://www.freetype.org

--- end of FTL.TXT ---

The TWAIN Toolkit is distributed as is. The developer and distributors of the TWAIN Toolkit expressly
disclaim all implied, express or statutory warranties including, without limitation, the implied warranties of
merchantability, noninfringement of third party rights and fitness for a particular purpose. Neither the
developers nor the distributors will be liable for damages, whether direct, indirect, special, incidental, or
consequential, as a result of the reproduction, modification, distribution or other use of the TWAIN Toolkit.

JSON for Modern C++
Copyright (c) 2013-2017 Niels Lohmann

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright (c) 2011 - 2015 ARM LIMITED
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

- Neither the name of ARM nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.
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THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS I1S" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL COPYRIGHT HOLDERS AND CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The following applies only to products supporting Wi-Fi.
(c) 2009-2013 by Jeff Mott. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions, and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the
following disclaimer in the documentation or other materials provided with the distribution.

* Neither the name CryptoJS nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS,"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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I Device Management Console Guide

» General Notes (Device Management Console)
» The Features of Device Management Console
» Starting Device Management Console
» Registering Printer
» Deleting Printer
» Checking Printer Status
» Managing Printer Colors
@« Checking Color Calibration Execution Status
@« Checking Calibration Link
« Performing Color Calibration
» Description of Device Management Console Screen
@« Main Screen

Main Screen (Menu Bar)
Main Screen (Printer Status Sheet)
Main Screen (Calibration Sheet)

@ Printer Management Dialog Box
@ Add Printer Dialog Box

@ Printer Details Dialog Box

@« Paper Status Dialog Box

« Calibration Dialog Box

« Calibration Monitor Dialog Box

@« Preferences Dialog Box
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I General Notes (Device Management Console)

When using Device Management Console, the following restrictions apply. Please familiarize yourself with
them before using it.
» See the Canon website for products that are compatible with Device Management Console.

» This guide primarily provides explanations using the screens that are displayed when you use the OS X
Yosemite 10.10 operating system.

I Connecting to a Printer

» Connecting to a Target Printer
We recommend using a network connection for printer connection.
» Connecting via SSL Encrypted Communication

Connecting via SSL Encrypted Communication is available with Device Management Console V1.2.0
or later.

In order to use SSL Encrypted Communication, you must first install a certificate on a computer with
Device Management Console installed.

The process for installing the certificate may differ depending on your setup. For more information,
search for "Registering Printer's Root Certificate to Local Computer for SSL Communication” on your
device's online manual homepage.

I Printer Power

» The printer information cannot be acquired when the printer power is turned off automatically or it is
turned off with the power button.

In addition, information cannot be acquired from the software when the printer auto power off state or
the printer button off state is canceled.

I Color Tone

» The color tone may not be stable even if color calibration is performed.

For details, search for and refer to the "Managing Colors" page from the home page of the Online
Manual for your model.
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I The Features of Device Management Console

Use Device Management Console to check the status of a printer connected by a network or USB and to
perform color calibration for a selected printer.

In addition, you can check the recommended level of color calibration execution, execution logs, and
calibration link status.

> Note

+ In Device Management Console, multiple printers that can print with the same color are called
calibration-linked printers.

I Checking Printer Status

Use the Printer Status sheet on the main screen to check the printer status.

= Checking Printer Status

I Checking Color Calibration Status

Use the Calibration sheet on the main screen to check the recommended level of color calibration
execution and execution logs.

= Checking Color Calibration Execution Status

In addition, you can also check the calibration link status.

= Checking Calibration Link

I Performing Color Calibration

Use the Calibration sheet on the main screen to perform a color calibration for the selected printer.

Performing color calibration improves color consistency by compensating for slight differences in how
color appears due to individual variations or aging among printers.

= Performing Color Calibration
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I Starting Device Management Console

Follow the procedure below to start the Device Management Console.

1. Execute any of the following:

* Click the Device Management Console button on the Management Tool sheet in the Quick
Utility Toolbox.

» Select Applications from the Finder's Go menu, and then double-click in the following order:
Canon Utilities folder > Device Management Console folder > Canon Device Management
Console icon.

+ Click the Device Management Console icon from Canon Utilities in Launchpad.

> Note

* Quick Utility Toolbox is a Canon software application.

The Printer Status sheet on the main screen of Device Management Console appears.

L ]

=]

i i | Calitraton

- That prrms 50 08 Manegid ek Gt DN tepadened Fegagy e prinmer om |Primer Manags e

Printers do not appear on the main screen at initial startup.

Register the managed printer while referring to "Registering Printer".
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I Registering Printer

Register the printer for which you want to check the printer status or color calibration execution status.

»>» Note

» The Calibration sheet does not appear for printers that do not support color calibration.
=
1. Click e ] button (or select Manage Printer from File menu).

R r a Calitration

- Thus prirmer 1 09 marugid huil ot b regitened. Ragisss 1 prirmer from [Prinser Mansgemsnt)

> Note

 This operation cannot be performed when acquiring information from the printer.

The Printer Management dialog box appears.

2. Click Add Printer button.
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Printer Managemant

Sef the printer to D managed.

Printer List: Mumber of Managed Printars: 0
Printor Namsg ~ Connection MAC Addmoss Staty
Add Printer,
Impart..
Caroul [ —
»>» Note

» For details on the Printer Management dialog box, see "Printer Management Dialog Box."

The Add Printer dialog box appears.

3. Select Bonjour in Search Method, and then click the Search button.
Add Printer

Searches for prinfers, and selects the printers to be registened.

Sgarch Method: Banjour H Search
IP Address:

Printer List:

Prievias Namg Conngetion

Search Oplions

Cancel

> Note

* To search by SNMP community, click the Search Options button, and then specify a Specify
community name.

 For details on the Add Printer dialog box, see "Add Printer Dialog Box."

The printers found appear in Printer List.
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»» Note

« If the printer you want to register does not appear, check that the printer power is turned on and
check the network status, and then search again.

* When Search Method is set to USB, a search for local printers is performed.

4. From list of displayed printers, select check boxes of printers to register, and click Add
button.

Add Printer

Searches for prinfers, and selects the printers to be registened.

Sgarch Method: Banjour H Search
IP Address:
Printer List:
Prievias Namg Conngetion
POTIR
B

Search Oplions

Cancel

The registered printers appear in the Printer Management dialog box.

5. Click the OK button.

Printer Managomant

St the prinder to be managed.

Printer List: Mumiber of Managed Printars: 1

Printor Nams ~ Connoction MAL Addrogs

#udd Prinbr.

Impart.. Export..

Cancel — ]
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»» Note

» To change the displayed printer names, use the Advanced Printer Settings dialog box that
appears when you click the Advanced Settings button.

Advanced Printer Sattings (I SEres)
Changes the printer name.

Printer Name: - . corios

Serial Number:

Cancel | (CIINNES

The registered printers appear on the main screen.

] Canon Davios Maragemant Consols

[ Printer Sratun [JIHESEY

- Rl printes b BTy WO O AR TengL

»» Note

» When switching the connection method of a registered printer between network and USB, first
delete the registered printer, and then register it again.
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I Deleting Printer

Delete a managed printer.

The deleted printer is deleted from both the Printer Status and Calibration sheets.

1. Click % button (or select Manage Printer from File menu).

L
=]

i r B Calaraton

= O prNGEY R B0 TN OF WIRTENGR.

»» Note

» This operation cannot be performed when acquiring information from the printer.

The Printer Management dialog box appears.

2. Select printer to be deleted and click Unregister button.
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Printer Managoemant

St the printer to e managed,

Printer List: Mumber of Managed Printors: 1
Printor Namag ~ Connocton MAC Addrogs Statup
Add Printer.. Uinragister Advanced Settings..
Impoet... Export...
cancel | (LD
22> Note

» For details on the Printer Management dialog box, see "Printer Management Dialog Box."

The selected printer is deleted from the Printer List.

. Click the OK button.

Prantar Managamant

Sad the prinder bo B managed,

Prinbar List: Humiber of Managed Printars: 0
Printor Nams ~ Connection MAC Addross Status
Audd Prinbar..
Impoet...
cancer | (D

The managed printer is deleted.
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I Checking Printer Status

Use the Printer Status sheet on the main screen to check the printer status.

2> Note
» To check the status of a printer, the managed printer must be registered in advance.

= Registering Printer

1. Click Printer Status tab (or select Printer Status from View menu).

®

B
¢
The Printer Status sheet appears.
2. Click C button (or select Update from View menu).
]
]
A i | Caliration
le]

- N pRPARE PR BT ETORN OF WITA.
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The printer status that appears on the main screen is up to date.

> Note

» Select a printer and click the ? button to display the Printer Details dialog box, allowing you to
check the detailed printer information.

Printer Details

Printer
Printer Name: - = zeries
Praduct Name: - o series
Connection: -
Installation Location: —

Firmware Version: =
Sarial Mumber: -

Status

For details on the Printer Details dialog box, see "Printer Details Dialog Box."

» This operation cannot be performed when acquiring information from the printer.

3. To see more detailed information, select a printer, and click the Printer Information button.

[ ] Canon Dwsics Managemant Console

- Hig prinder Rl B0y STONS OF WRTERG.

The Web browser starts, and the main screen of the Remote Ul for the selected printer appears.
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Printer status

Dratalls Ready to print.
When a password is set,

password entry will be

requested. Estimated ink levels

Manial | Onling)

2% Important

* You cannot view detailed information about a printer with Remote Ul for a printer connected with
USB or IPv6.
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I Managing Printer Colors

» Checking Color Calibration Execution Status
» Checking Calibration Link

» Performing Color Calibration

34



I Checking Color Calibration Execution Status

Use the Calibration sheet on the main screen to check the recommended level of color calibration
execution and execution logs.

= Checking Advisability of Executing Color Calibration

= Checking Color Calibration Execution Logs

I Checking Advisability of Executing Color Calibration

You can check whether color calibration needs to be executed.

1. Click Calibration tab (or select Calibration from View menu).

L ]

= |

Calioration

B

- i RIS Pl BT TR OF WRTENg

2. From the printer list, select the printer for which you want to check the advisability of
executing color calibration.
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L] Canon Dasics Maragemant Console

bectu e L
Prirter: ) datia Typee Pralo Papsr Plea Glossy 1| |
[T e Gasteation
Calibraton sdvastilty:
Cairated E A
» Mgy Troa Ligbus Dt e Tima of Lt C
G Phets P Pus Gy 1| Mormal -

Papar Statos

Calibration Moniter

3. Select the media type in Media Type.

L Canon Dwsics Maragemant Consols
B B
ot Gl |
Prirtier: [v] Mdactia Trpa: Privio Paper Phes Glossy 1| EI
[ i o R Casration
Caloration sdvisatiity;
Cabirated 8 &
= Mgcka Trow b 1) Dute ard Time of Lt T
F Prote Paged Plus Gioagy 1l Mormal - .
Papar Siaton
Calbration Mondor
12> Note

* When Media Type cannot be selected, the paper loaded in the printer appears.

4. Check the progress bar of Calibration advisability.
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SN Calbration |
Prirter: [/ identin Tope: Proio Papsr Ples Glosay 11 ()
BT e

Calipegiaon

Calbration sdvaatabty; | 1

Cadzaa 1] 7] v
= Macka Troe Tt Dute g Tiema oF
T Press Pagsd Pl Giossy 1 Mpgr—al

Papar Statun

Calisration Moniter

When the progress bar is yellow or red (progress bar is at 90% or more), we recommend that color
calibration be executed.

32 Important
» The progress bar display is used for reference for performing color calibration.

Perform color calibration when replacing the printhead or when you are concerned about
differences in color tone.

I Checking Color Calibration Execution Logs

You can check the color calibration execution log for each paper.

1. Click Calibration tab (or select Calibration from View menu).

]

- Rl it bl By O O ABTIGL
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2. From printer list, select printer for which you want to check color calibration execution log.

L] Canon Dasics Maragemant Console
erte St [T
Prirter: ) datia Typee Pralo Papsr Plea Glossy 1| |

[T Caswration

Calibration scdvaatdty;

Cadiea e E Fud
» Mgy Troa Ligbus Dt e Tima of Lt C
G Prots Pigssd Plus Gy 1l Merrrial - R .

Papar Status

Calibration Moniter

3. From paper list display criteria, select All.

L Canon Dwsics Maragemant Consols
et sen. ETITE
Frirter: C dectia Typee Prasio Paper Fhat Giossy 1| B
BT o Caoration
Calbration adviaatdty:
[ A EI &
= il T ey e wred Tma of Linn
G Photo Page Pius, Gioasy 1| feormal - - e
Carrad Lt sairae
Eatn Hbavipwsaght Fot AP Uinksdren
Flagaid Lirdcrgpam
Plagaic A Liricmgwm
Fhedrnrpmeghl Fra Aol Pager i gram
Hadreywaighi Pholo Paper i talre
Fligheat Daradty Fine Art Paga  Uinkeown
Irix Jut Hagaks Lricmgran

Papar Siaton

Calieration Moniter

4. From paper list, select paper for which you want to check details and click Paper Status
button.

38



™ g D Maragemant Conpole

-}
Prinier Statun
Prirter: ) datia Typee Prsto Paper Pt Glossy 1| |5
Mol Calioration
Calipration sdviaabilty:
A B8 [

|mm_i
P T

Exiea Hagrvpwaght Fng At P (AL,

Flagaic Linicngran
Flagaid A Uinicngwr
Fieineweight Fre At Paper  Uficsden
Hedreyweghl Phalo Paper Wrimare
Hagheat Deradty Fing Art Papas  Uinisraran
i Jui Hlagakc Linizropam

Paper Statos

Calibration Moniter

The Paper Status dialog box appears.

Paper Status
Media Type: Photo Paper Plus Glossy ||
Calibration
Paper: Photo Paper Plus Glossy ||
Data: - - =

Calibration advisability:

You can check the color calibration status for the selected paper.

23> Note

« For details on the Paper Status dialog box, see "Paper Status Dialog Box."
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I Checking Calibration Link

In Device Management Console, multiple printers that can print with the same color are called calibration-
linked printers.

Calibration-linked printers are grouped with the same calibration group name and displayed.
22 Important
+ Calibration link is performed for multiple printers that meet the following conditions.
» The printer belongs to the same series that supports calibration link.
+ The same media type is selected in Calibration sheet > Media Type on the main screen.
For models for which Media Type cannot be selected, the same media type is loaded in the printer.

* Color calibration is performed at least once for each printer with the above paper.

1. Click Calibration tab (or select Calibration from View menu).

- Rl printes b BTy O O AR TengL

Printer infarmation

The Calibration sheet appears.

2. To right of printer list, click c' button (or select Update Calibration Link from View
menu).
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Privder Siatum - Calih o |

Prirter: lleeiia Type: Prato Paps Ples Gloasy Il )
[ S e [ s T Gatloration
S | 1
Calbraton advasmsity
Cacraied <] Cr
» Mada, Troe Eirtin Custe i Tima: of Lkt

o Phots Pagsd P Giasdy 11 Mormal

Paper Shaton

Calisration Moniter

Calibration-linked printers are grouped with the same calibration group name and displayed.

B T
L UL Ul Calibeation |
Privtar: [+ idedia Type: Prodo Papes Ples Olosay 1| 1)
Tlakbratian group: 1 L) i i ey
e |
Calratan aghaatelty
Cainrati=) 8 Cr
~ Mg Troe Dot dred Tiems: of Rt
= Prots Paps Plus Giossy 1| Mermal
Paper Shatun
Caltration Monitsr
2 Important

* For printers displayed with  ®* | you may not be able to print with the same color tone. See the

message displayed in the guide message area, and print after confirming that * is not
displayed.

When "The calibration target in the media information file is not up-to-date." appears for a printer,
export the media information for any printer not displaying this message to a file using Media
Configuration Tool, and then import the exported media information to the printer displaying this
message. For information on exporting and importing media information, search for and refer to
"Media Configuration Tool Guide" from the home page of the Online Manual for your model.
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»» Note
* Move the mouse pointer over Calibration group to display the media type to be grouped.

» Double-click Calibration group to open and close the Calibration group tree.
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I Performing Color Calibration

Use the Calibration sheet on the main screen to perform color calibration for the displayed printer.

22 Important

* You must load paper into the printer to perform color calibration.

For details on the paper that can be used for color calibration, search for and refer to the following
pages from the home page of the Online Manual for your model.

* Model that supports roll paper
"Paper Information List"
» Model that does not support roll paper

"Paper that Can Be Used in Color Calibration"

1. Click Calibration tab (or select Calibration from View menu).

[ ]

-]

- Rl printes b BTy O O AR TengL

The Calibration sheet appears.

2. From printer list, select printer for which you want to perform color calibration.
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e Dureucd Waragemaent Conisode

L L BN Catteaton |
O M Ty Proto Papss Pt Glasy 1| |

(T

Calpration
Callration advaamskty:
Cadaaied E
» Migeiy T Digtus Dt ared Tima of st
7 Prots Pagsd Plus Gloady 1| Mermial - O .
Eaper Statun

Calibration Moniter

3. Click Calibration button (or select Calibration from Start menu).

Cann Dt Marsgbmint Conpols

Pricter Statun

[roe, e Profo Papsr Ples Giossy 1 |
T o
Callration achinatdlty:
Cabdpraing E C.-
= \Vpia Trow ) Dute el Timg of Lot ©
5 Photo Paged Plus Glossy 1| Mormal - .
Papar Staty

Caleration Moniter

The Calibration dialog box appears.

4. Select the Media Type for color calibration.
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@0 Calibration [ s8ries)

Cenfirm the color ealibration settings.
After calibration is started, it takes about 10 minutes.

Product Name: e saries

Media Type: . B
Papar Source: -
Confirmation Message:

Load paper inlo the s e
The color calibration correction values will be applied 1o only this media lype.
Calibration infarmation for ™ S S e

Dale i & e .
Status:Mormal

Callbration Maonitor Cancel

23» Note

» The media type for the paper fed on the printer appears depending on your model.

5. Verify the Status in the Confirmation Message.

® Calibration (I . series)

Confirm the color calibration settings.
After calibration is started, it takes about 10 minutes.

Product Mame: . - series
Media Type: - E
Paper Source:

£y

Confirmation Message:
Load papar inlo the S S

The color calibration correction values will be applied to only this media type.

Calibration information for S S S s

ISla'tus:N:}rmﬂl i

Calibration Manitor Cancel “
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The Status in the Confirmation Message will let you know if color calibration is required.

3% Important

« If you are not performing color calibration, click the Cancel button.

6. Verify the Paper Source.
& Calibration ( series)

Confirm the color calibration settings.
After calibration is started, it takes about 10 minutes.

Product Mame: sS@ries

Media Type:
Paper Source: :

Confirmation Message:

Load paper into the

The color calibration correction values will be applied to only this madia type.

Calibration information for
Date:
Status:Nomsal

Calibration Maonitor Cancel ' oK

The paper sources for which color calibration can be performed are displayed for the paper in Media
Type.

If the displayed paper source and the paper loaded to perform color calibration are different, reload the
paper in the paper source displayed in Paper Source.

> Note

» Depending on your model, you can select the Paper Source.

* If you are using a PRO-1000 or PRO-500 model, only the Top Feed can be used as the paper
source for color calibration.

7. Click the OK button.

The color calibration starts and the Calibration Monitor dialog box appears.

46



sarias Exscuting

3% Important

» To update the color calibration progress status, you must click the C button.

« After 30 minutes have elapsed from the start of the color calibration and you close the dialog box,
you cannot check the progress status of the color calibration even if you display the Calibration
Monitor dialog box the next time.

» Depending your model, you cannot check the progress status of color calibration for a printer
connected by USB by closing this dialog box, and then displaying the Calibration Monitor dialog
box.

»» Note

* If you want to stop the color calibration, select the printer and then click the Cancel Calibration
button.

» To close this dialog box, click the L (Close) button.
Color calibration cannot be canceled by closing this dialog box.

* You can also display this dialog box by clicking the Calibration Monitor button on the
Calibration sheet.
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I Description of Device Management Console Screen

» Main Screen

@ Main Screen (Menu Bar)
@ Main Screen (Printer Status Sheet)

@ Main Screen (Calibration Sheet)

¥

Printer Management Dialog Box

¥

Add Printer Dialog Box

¥

Printer Details Dialog Box

¥

Paper Status Dialog Box

¥

Calibration Dialog Box

¥

Calibration Monitor Dialog Box

¥

Preferences Dialog Box
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I Main Screen

The main screen of Device Management Console consists of a menu bar, toolbar, main area, and status
bar.

Canon Device Management Console File View Execute Help [1}

@
(3) . ¢

am [T [ T

Ganon Darvice Maragement Conscle

- Fi pringsd haik Y STON OF WVTING

(4)

Prirter information

= (1) Menu Bar
= (2) Toolbar

= (3) Main Area
= (4) Status Bar

| (1) Menu Bar

Select the menu items for the necessary operations.

= Main Screen (Menu Bar)

| @ Toolbar

Displays the buttons of functions frequently used in Device Management Console.

Use the View menu in the menu bar to show/hide the toolbar.

? button

The Printer Management dialog box appears, allowing you to manage managed printers.

'1% button

The Printer Details dialog box appears, allowing you to check the detailed information for the
selected printer.
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I (3) Main Area

The main area includes the Printer Status sheet and Calibration sheet.

Click Printer Status tab to display Printer Status sheet, and click Calibration tab to display Calibration
sheet. You can also use the View menu in the menu bar to select the display.

= Main Screen (Printer Status Sheet)

= Main Screen (Calibration Sheet)

I (4) Status Bar

The Device Management Console settings status and printer communication status appear.

Use the View menu in the menu bar to show/hide the status bar.
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I Main Screen (Menu Bar)

The menu bar on the main screen has the following menus.
Canon Device Management Console File View Execute Help

= Canon Device Management Console Menu

= File Menu
= View Menu
= Start Menu

= Help Menu

I Canon Device Management Console Menu

Canon Device Management Console [ITBRT

About Canon Device Management Console
Preferences...

Hide Canon Device Management Console  3H |
Hide Others N 3EH

Quit Canon Device Management Console 30

About Canon Device Management Console
You can check the Device Management Console version.

Preferences

The Preferences dialog box appears. You can select the items to appear on the Printer Status
sheet on the main screen.

Quit Canon Device Management Console
Exits Device Management Console.

| File Menu

RaICW View Start Help

|
Manage Printer... 38L

Printer Details

The Printer Details dialog box appears, allowing you to check the detailed information for the
selected printer.

Manage Printer
The Printer Management dialog box appears, allowing you to manage managed printers.
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| View Menu

B start  Help

Show Tab Bar 13T §
+ Toolbars T
| ' Status Bar 38/
Update NER
v Printer Status {+38P
t  Calibration {+38C
Paper List [ ]

Enter Full Screen

Toolbars
Shows/hides the toolbar on the main screen.

When the check box is selected, the toolbar appears.

Status Bar
Shows/hides the status bar on the main screen.

When the check box is selected, the status bar appears.

Update
The printer status that appears on the Printer Status sheet is up to date.

When the check box is selected, it is updated regularly.

Update Calibration Link
Updates the printer list on the Calibration sheet.

Printer Status/Calibration
Select Printer Status to display the Printer Status sheet.

Select Calibration to display the Calibration sheet.

Paper List
Selects the media types displayed in the paper list on the Calibration sheet.

Calibrated
Only color-calibrated paper appears.

All
All paper appears.

Custom Paper
Only custom paper appears.

Custom paper is paper added with Media Configuration Tool.

To execute color calibration with custom paper, the calibration target for that paper must be
created.
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For details on custom paper and creating a calibration target, search for and refer to the "Media
Configuration Tool Guide" from the home page of the Online Manual for your model.

Paper Status
The Paper Status dialog box appears, allowing you to check the color calibration status of the
selected paper.

Update Paper List
Updates the paper list on the Calibration sheet.

I Start Menu

 Start JREN

Calibration 2 K
Calibration Monitor {+38K

Printer Information
The Web browser starts, and the main screen of the Remote Ul for the selected printer appears.

Calibration
The Calibration dialog box appears, allowing you to perform color calibration for the selected paper.

Calibration Monitor
The Calibration Monitor dialog box appears, allowing you to check the color calibration progress
status.

I Help Menu
' Search

Instructions

Instructions
The Online Manual appears.

53



I Main Screen (Printer Status Sheet)

Use the Printer Status sheet to monitor the status of managed printers.

»>» Note

« If the printer you want to manage is not displayed, use the Printer Management dialog box to register
the printer.

= Registering Printer

- hig pringer bk By STONS OF WTENGE.

(3) (4)

= (1) Printer Status Update Area

= (2) Printer Status Display Area

= (3) Message Area

= (4) Advanced Printer Information Area

I (1) Printer Status Update Area

¢

button
Updates the printer status.

I (2) Printer Status Display Area
The status for each printer appears.

¥>» Note
* Click the heading to sort by clicked item.

Warning / Error Icons
The icons below appear to the left of Printer Name when a printer warning or error occurs.
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»» Note

» For details on warnings and errors, click the Printer Information button to display Remote Ul, or
search for and refer to "Troubleshooting" from the home page of the Online Manual for your
model.

A warning has occurred.

Q

An operator error has occurred.

@

Information about the remaining amount of ink, etc.

f

An error requiring repair has occurred.

Printer Name
The name of the printer appears.

Connection
Displays the IP address of printers connected via the network and the connection port name of
printers connected via USB.

Warning/Error Count
The number of warnings and errors occurring appear.

Status
The simplified status of the printer appears. If there are multiple warnings and errors, the highest
priority one appears.

I (3) Message Area

Messages for the status of all managed printers appear.

I (4) Advanced Printer Information Area

Printer Information button
The Web browser starts, and the main screen of Remote Ul for the selected printer appears, allowing
you to check the printer information details.

3% Important

* You cannot view detailed information about a printer with Remote Ul for a printer connected with
USB or IPv6.
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I Main Screen (Calibration Sheet)

Use the Calibration sheet to execute color calibration for the managed printer and to check the color
calibration status.

»» Note

« If the printer you want to manage is not displayed, use the Printer Management dialog box to register
the printer.

= Registering Printer

E-= ]
L Ul Caltwation |
Prirter: Cr || ndectia Type: Pravio Paper Ples Glossy |
EEETTTTEETEE || o pr—rem
(2)
Capaaton sdvaamkty
Cabiceated o C
= Meka Troe P e e T
o Phote Paper Pus Glossy 1 Mormal
(1) ‘
(3)
Faprer hat e
(4]| Calibration Moniter

= (1) Printer List Area

= (2) Execute Color Calibration Area

= (3) Color Calibration Execution Log Area

= (4) Color Calibration Progress Status Area

| (1) Printer List Area

The managed printers are organized and displayed by color calibration status.

Click the C' button to update the printer list.
2> Note

» A warning related to color calibration has occurred on printers with ®* displayed.

The error details appear in the guide message area of "(2) Execute Color Calibration Area".

* Printers that do not support color calibration will not be listed.

In Device Management Console, multiple printers that can print with the same color are called calibration-
linked printers.
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Calibration-linked printers are grouped with the same calibration group name and displayed.

¥Calibration group 1

series [ ]

3% Important

« Calibration link is performed for multiple printers that meet the following conditions.
» The printer belongs to the same series that supports calibration link.
» The same media type is selected in Calibration sheet > Media Type on the main screen.

For models for which Media Type cannot be selected, the same media type is loaded in the
printer.

* Color calibration is performed at least once for each printer with the above paper.

3> Note
* Move the mouse pointer over Calibration group to display the media type to be grouped.

» Double-click Calibration group to open and close the Calibration group tree.

I (2) Execute Color Calibration Area

Media Type: Photo Papar Plus Glossy || )

(2-1)

Calibration advisability:

Media Type
Select a media type supported by the printer.

32 Important

» Depending on the model used, displays only the media type loaded in the printer-.

(2-1) Guide message area
Messages related to color calibration appear.

Calibration button
The Calibration dialog box appears, allowing you to perform color calibration.

Calibration advisability
Displays the advisability for executing color calibration. The progress bar grows until the time when
calibration is recommended.

I (3) Color Calibration Execution Log Area

The color calibration execution log for each paper appears.
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|_calibrated gl ; 3—1 ) C

~ Modia Type Snus Do gnd Tima of Last
' Photo Paper Plus Glossy |I Mormal

(3-2)

Paper Status

(3-1) Paper list display conditions
From the drop-down list, select the criteria for displaying items in the paper list.

Calibrated
Only color-calibrated paper appears.

All
All paper appears.

Custom Paper
Only custom paper appears.

Custom paper is paper added with Media Configuration Tool.

To execute color calibration with custom paper, the calibration target for that paper must be
created.

For details on custom paper and creating a calibration target, search for and refer to the "Media
Configuration Tool Guide" from the home page of the Online Manual for your model.

C

button
Updates the paper list.

(3-2) Paper list
The color calibration execution log for each paper appears.

»» Note
+ Click the heading to sort by clicked item.

. [E] appears for paper displayed in Media Type of "(2) Execute Color Calibration Area".

Media Type
The paper name acquired from the printer appears.

Status
The status and guide messages related to color calibration appears.

»» Note

« If you delete or hide the paper used for the color calibration in Media Configuration Tool, that
paper will be displayed as Unknown Paper in Status column.

In such cases, use different paper and carry out the color calibration.
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Date and Time of Last Calibration
The date color calibration was last performed appears.

Paper Status button
The Paper Status dialog box appears, allowing you to check the color calibration status of the
selected paper.

I (4) Color Calibration Progress Status Area

Calibration Monitor button
The Calibration Monitor dialog box appears, allowing you to check the color calibration progress
status.

32 Important
* You cannot check the progress status for the following color calibration.
* Color calibration performed from the operation panel of a printer

* Color calibration of a printer connected by USB (for model that does not support roll paper)
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I Printer Management Dialog Box

You can register and delete managed printers .

You an also change a printer's display name, and export and import information for managed printers.

—
Click 'ﬁ' button or select Manage Printer from File menu to display Printer Management dialog box.

Prantar Managemant

Sed the printer bo be managed.
Printor List: MNumbar of Managed Printors: 1

Printor Namg ~ Gennection MAG Addross Status

Auchd Prinbar, Linragiatar Advanced Saltings

Impoet.. Export..

Cancel —

Printer List
Displays the list of managed printers.

Number of Managed Printers
Displays the total number of printers that appear in Printer List.

Printer Name
The printer name appears.

Connection
Displays the IP address of printers connected via the network and the connection port name of
printers connected via USB.

MAC Address
The MAC address of the printer appears.
3> Note

* For printers that support wired and wireless LAN, the MAC address that appears here is the
wired LAN MAC address.

Status
The printer support status appears.

Add Printer button
The Add Printer dialog box appears, allowing you to register a managed printer.

Unregister button
The printer selected in Printer List is deleted.
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»» Note

* You cannot click this button if a printer is not selected.

Advanced Settings button
The Advanced Printer Settings dialog box appears, allowing you to change the printer display name.

»» Note

* You cannot click this button if a printer is not selected.

Import button
Imports the managed printer(s) from a file.

The managed printers that are imported in Printer List appears.

3» Important

* When importing a printer connected with IPv6, you must turn on the printer and establish
communications.

If you import while communications are not established, Not Found appears under Status in the
Printer List, and the printer cannot be registered. If this happens, temporarily delete the printer
from the Printer List with the Unregister button, turn on the printer, and import again after the
communications have been established.

Export button
Exports the managed printers displayed in Printer List to a file.

»» Note

* A printer connected by USB cannot be exported.
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I Add Printer Dialog Box

You can search for a printer to be managed and register it to the list of managed printers.

Click Add Printer button on Printer Management dialog box to display Add Printer dialog box.
Add Printer
Searches for printers, and selects the printers to be registened.
Sgarch Mathod: Boanjour & Search
IP Addrass:

Prrinter Lisk:

Pricilagd Mamg Conngction

SOTIDS
Saries

Search Oplions

Cancel

Search Method
Select the printer search method.

Bonjour
Search for printers connected by Bonjour.

Auto (IPv4/IPv6)
Searches for IPv4 and IPv6 printers.

IPv4
Searches by specifying the IPv4 IP address in IP Address.

IPv6
Searches by specifying the IPv6 IP address in IP Address.

uUsB
Searches for printers connected via USB.

IP Address
When IPv4 or IPv6 is selected in Search Method, enter the IP address of the printer for which to
search.

Search button
Starts printer search using the selected search method.

Printer List
The printer search result appears.

Printer Name
The model names of the printers found appears.

To register a printer, select the check box next to the model name.
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Connection
Displays the IP address of printers connected via the network and the connection port name of
printers connected via USB.

Search Options Button
Opens the Search Options dialog box.

Configure this when searching for a specific SNMP community.

Stop Searching button
Click to stop the search.

Add button
When the check box is selected, the printer is registered to the managed printers, and the Add Printer
dialog box closes.
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I Printer Details Dialog Box

The printer details of the selected printer appears.

p—
Click 0 button or select Printer Details from File menu to display Printer Details dialog box.

Printer Details

Printer
Printer Name: series
Praduct Name: saries
Ceonnection:

Installation Location:
Firrmware Varsion:
Serial Numlber:

Status

Printer Name
Displays the name of the printer that appears in Device Management Console.

Product Name
The product name of the printer appears.

Connection
Displays the IP address of printers connected via the network and the connection port name of printers
connected via USB.

Installation Location
The installation location of the printer appears.

»» Note

» Nothing appears if no information can be acquired from the printer.

» Depending on the model used, nothing may appear.

Firmware Version
The version of the firmware installed on the printer appears.

»» Note

» Nothing appears if no information can be acquired from the printer.
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Serial Number
The serial number of the printer appears.

Status
The simplified status of the printer appears.
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I Paper Status Dialog Box

The color calibration status for the paper selected in the paper list appears.

Click Paper Status button on Calibration sheet or select Paper Status from View menu to display Paper
Status dialog box.

Paper Status

Meadia Type: Photo Paper Plus Glossy ||
Calibration
Paper: Photo Paper Plus Glossy ||
Date:

Calibration advisability:

Media Type
The name of the paper selected in the paper list appears.

Calibration

The information of the color calibration applied to the selected paper appears.

The information of the selected paper only when color calibration has been executed for the selected
paper appear.
Paper
The paper name only when color calibration is executed appear.
Date
The date color calibration was executed appear.
Calibration advisability

Displays the advisability for executing color calibration. The progress bar grows until the time when
calibration is recommended.
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I Calibration Dialog Box

You can check the color calibration status and perform color calibration.

Click Calibration button on Calibration sheet or select Calibration from Start menu to display Calibration
dialog box.

& Calibration ( series)

Confirm the color calibration settings.
After calibration is started, it takes about 10 minutes.

Product Name: saries
Media Typa: ﬂ

Paper Source:

Confirmation Message:
Load papar inlo the

Thee color calibration correction values will be applied to only this madia type.

Calibration information for

Date:
Status:Nomal
Calibration Monitor Cancel “
Media Type
Select a media type supported by the printer.
2> Note

» The media type for the paper fed on the printer appears depending on your model.

Paper Source

Displays the paper source that can be used to perform color calibration with the media that appears in
Media Type.

»» Note
» Depending on your model, you can select the Paper Source.

« If you are using a PRO-1000 or PRO-500 model, only the top feed can be used as the paper
source for color calibration.

Confirmation Message
Messages related to color calibration appear.

Calibration Monitor button

The Calibration Monitor dialog box appears, allowing you to check the color calibration progress
status.
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OK button
The color calibration starts and the Calibration Monitor dialog box appears.
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I Calibration Monitor Dialog Box

You can check the progress status of the color calibration.

Click Calibration Monitor button on Calibration sheet, Calibration Monitor or OK button on Calibration
dialog box, or select Calibration Monitor on Start menu to display Calibration Monitor dialog box.

22 Important
* You cannot check the progress status for the following color calibration.
* Color calibration performed from the operation panel of a printer

+ Color calibration of a printer connected via USB (except when displayed with the OK button on the
Calibration dialog box on a model that does not support roll paper)

BB S Executing

Printer Name
The printer name appears.

Media Type
The media type appears.

Date
The date when color calibration was started appears.

Status
The progress status of color calibration appears.

Cancel Calibration button
Stops color calibration on the selected printer.

»>» Note

» To close this dialog box, click the #® button or select Quit Canon Calibration Tool from the Canon
Calibration Tool menu.

Color calibration cannot be canceled by closing this dialog box.
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I Preferences Dialog Box

You can select item to be displayed in Printer Status.
You can also change the order in which the items are displayed.

Preferences

You can select items to be displayed in Printer Status from
the following. Check the items that you want to display.

Category to Be Displayed:

Printer Name

Connection
Warning/Error Count
Status
Product Name
Installation Location
Firmware Version
! Up
Serial Number

Down

Default Cancel ﬁ

Category to Be Displayed
You can select the items to be displayed in Printer Status from the following. Check the items that you
want to display.

»» Note

* You cannot remove the check mark from Printer Name.

Up
Moves the selected item up one row.

Down
Moves the selected item down one row.

Default
Restores the selected items and display order to the default settings.
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